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iCEdragon Demo Board

Introduction

Thank you for choosing the iCEdragon™ Demo Board. This board is designed to help you develop hardware solu-
tions based on the Android OS using the iCE40™ ultra-low density FGPA.

To get the latest news, updates and downloadable resources for the iCEdragon Demo Board – including demos 
and documentation, visit the Lattice web site at www.latticesemi.com/boards and follow the links to the iCEdragon 
Demo Board. 

Features

• iCE40-HX8K FPGA in 256-ball caBGA package

• Generous I/O access on PCB

• Six status LEDs

• Two pushbuttons

• USB mini plug

• IR Sensor

• Two IR transmitters

• On/off switch

• 8 Mbit SPI serial configuration PROM

• USB mini cable included

Figure 1. iCEdragon Demo Board

The following items are not included with the iCEdragon Demo Board, but may be required to fully utilize the board 
in some situations:

• Programming Cable: Lattice HW-USBN-2A may be used.

• DragonBoard development platform: See below for more details
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Software Requirements

The following software is available for download from the Lattice web site. Go to: www.latticesemi.com/software
and follow the appropriate links. 

• iCEcube2™: For development with the iCE40 FGPA

• Programmer: For programming the iCE40 FPGA with a Lattice programming cable (cable available separately)

In addition, drivers and development software may be required for development with the Andriod OS. Specific 
details will depend on the level of development you intend to complete. 

DragonBoard

The iCEdragon Demo Board is designed exclusively for use with the DragonBoard development system, available 
separately from BSquare. The DragonBoard is a system to aid in development of hardware systems based on the 
Android OS. The iCEdragon Demo Board is not designed for stand-alone operation; the DragonBoard development 
system is required to both power and program the iCEdragon Demo Board, as well as to run the demonstration(s) 
described in this document. 

For more information on the DragonBoard kits and options, visit the BSquare website at: 
www.bsquare.com/store-products.aspx

iCEdragon Demo Board Default Jumper Settings

Table 1. iCEdragon Demo Board Default Jumper Settings

Qualcomm IR-I2C Bridge Demo Setup

The iCE40 FPGA on the iCEdragon Demo Board comes pre-programmed with the Qualcomm IR-I2C Bridge Demo 
described below. The programming file and source code for this demo can be downloaded from the Lattice website 
at www.latticesemi.com/boards (navigate to the iCEdragon Demo Board page). 

The Qualcomm IR-I2C Bridge Demo setup consists of the iCEdragon Demo Board which includes an IR-Receiver 
interfaced with an iCE40 ultra-low density FPGA. The iCEdragon Demo Board is interfaced with a J6 connector 
(Sensor board) of the DragonBoard using I2C and interrupt lines. A Sony RMTD301 is used as the IR-Transmitter.

RS232 and OTG-to-USB connections are made between the DragonBoard and a host PC. These are used for 
serial debugging and ADB connectivity, respectively.

A serial log can be seen on a CuteCom graphical serial terminal or any other serial console.

An ADB log can be seen on the terminal by using the command ‘$adb shell’ followed by ‘#logcat’. 

Jumper Parameter Setting

J3 VCCIO0 Set at VCCVAR (the voltage on Bank 0, where IR Tx and Rx parts are connected).

J5 VCCIO1
Set at 1V8. This is the voltage on Bank 1 where the DragonBoard interfaces are wired. Must be set 
to 1V8 for compatibility with DragonBoard levels.

J19 PWRSEL
Set at DGN. Indicates the source of power, will be 2.85V from the DragonBoard’s J6 connector for 
DragonBoard-related demos. This renders VCCVAR at 2.85V throughout the board.

J14 VCCIO2 Set at VCCVAR so that LEDs can light as required.

J7 VCCIO3 Set at 1.8V. No connections for current demos, set it at the lowest voltage.



4

iCEdragon Demo Board

Figure 2. Qualcomm IR-I2C Bridge Demo Setup
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Interrupt Configuration

1. Identify the GPIO Number

The DragonBoard makes use of ACCIL_IRQ (Pin6) on the J6 connector for interrupt. 

As per the schematics (8060DragonBoard_Schematic_CPU_Carrier_Board_(110311).pdf and 
8060DragonBoard_Schematic_Main_Board_(091611).pdf), the GPIO-57 pin of APQ8060 is connected to the 
ACCEL_IRQ pin.

2. Print the IRQ Number

The interrupt number is printed by adding the following lines to the board support package file found in the fol-
lowing path: 

..../8060_v3/kernel/arch/arm/mach-msm/board-msm8x60.c
#define GPIO_IRDETECT_IRQ  57
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Under ‘static void __init msm8x60_dragon_init(void)’ add the following lines:

uint32_t irq;
gpio_request(GPIO_IRDETECT_IRQ, "IR-DETECT"); // REQUEST GPIO 57
gpio_export(GPIO_IRDETECT_IRQ, 0); // EXPORT GPIO 57
gpio_direction_input(GPIO_IRDETECT_IRQ); // INPUT DIRECTION GPIO 57 
printk(KERN_EMERG " PRINTING IRQ NUMBER \n");   // DEBUG
irq = gpio_to_irq(GPIO_IRDETECT_IRQ); // GET IRQ NUMBER
printk(KERN_EMERG " IRQ NUMBER of GPIO-57 : %d\n", irq); // DEBUG

Build the kernel and flash boot.img file onto the DragonBoard as explained in Steps 5 and 7. 

The boot log generated during reboot will print the IRQ number as follows:

IRQ NUMBER of GPIO-57 : 313

Note: Modified ‘board-msm8x60.c’ is given with this document and can be found in the following location: 

/8060_v3/kernel/arch/arm/mach-msm/board-msm8x60.c

3. Identify I2C Device Lines

The I2C device line registered on the J6 connector is identified from the device file of the DragonBoard:

…./8060_v3/kernel/arch/arm/mach-msm/device-msm8x60.c

It is identified that i2c-5 lines are used on the J6 connector (sensor connector). This device lines are used to 
read and write from the iCEdragon Demo Board. 

4. Interrupt Handling Driver in Kernel

The interrupt handling driver file ‘I2C_irdetect_dev.c’ and respective modified ‘Makefile’ are provided with this 
document. These files exists in the path below:

/8060_v3/kernel/drivers/i2c/

Simply copy the above driver file and Makefile to the following Android kernel path:

…./8060_v3/kernel/drivers/i2c/

Now, proceed to build the kernel as described in the following steps.

5. Build the 8060_V3 Android Kernel for the DragonBoard

a. To clean all the previously-built directories and image files, use the command below:

$mke clean

b. To build the kernel source code, use these commands:

$sudo -s
$cd …./8060_v3/
$./build.sh
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6. Edit init.rc and Rebuild Kernel

When building the kernel source code for first time after using the ‘$make clean’ command, the default init.rc 
file will be created in this location:

…./8060_v3/out/target/product/msm8660_surf/root

Note: A modified init.rc file is provided with this document and can be found in the following path:

/8060_v3/out/target/product/msm8660_surf/root/init.rc

Use the commands below to edit the init.rc file:

$cd …./8060_v3/out/target/product/msm8660_surf/root
$sudo vi init.rc

Add the following lines to the init.rc file:

mount debugfs debugfs /sys/kernel/debug
chmod 0777 /dev/i2c-5 
chmod 0777 /sys/kernel/debug/IR_detect
chmod 0777 /system/etc/dbus.conf
chown system system /system/etc/dbus.conf
chown system system /dev/i2c-5
chown system system /sys/kernel/debug/IR_detect

After editing the init.rc file, save it and rebuild the kernel for the changes to take effect in the boot.img file. 

Re-build the kernel source code using the commands below:

$sudo -s
$cd …./8060_v3/
$./build.sh

Note: Do not use the ‘$make clean’ command during re-build as this will overwrite to default init.rc file.

Once the build is complete, follow the steps below to flash the boot image to the board.

7. Flash the Boot Image to the DragonBoard

a. Run the command below on the terminal to enter Root Mode:

$sudo -s

b. Reboot the DragonBoard in Fastboot Mode. To do this, hold down button 5 on the keypad during 
reboot.

The DragonBoard can be rebooted to Fastboot Mode by pressing the Power button on the board for 
few seconds until the power-off option is shown on the touch screen. Now hold down button 5 on key-
pad and click the Power Off option shown on the touch screen. Hold down button 5 until the reboot is 
complete.

Note: Not holding down button 5 on the keypad during reboot will reboot the board with the existing 
Android operating system.

c. Verify FastBoot Mode. When the board is in FastBoot Mode mode, the screen is blank. Executing the 
command below on the terminal with root permission will list the FastBoot device number and its 
name:

 $fastboot devices

 The board is now ready to be flashed with the boot.img file.
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d. Type the command below to flash the boot.img file:

$cd …./8060_v3/out/target/product/msm8660_surf/
$fastboot flash boot boot.img

If the boot.img file is installed correctly, you will see the OKAY and FINISH comments.

e. Re-boot the DragonBoard to see the new boot image in effect. The following command will reboot the 
board to load the Android operating system:

$fastboot reboot

8. Build the IR_Scanner Application

a. Import the project to your Eclipse workspace.

The IR_Scanner application source is located in path given with this document:

Application/IR_Scanner

Open the Eclipse IDE with the Android SDK and ADT plug-in installed. 

Click File > Import > General >Existing Project into the workspace.

Click Next and under the Project Options window, browse to select the above project location under 
the root directory. Click Next.

Select the Android 2.3.3 option and click Finish.

The IR_Scanner project is successfully imported into the workspace.

b. Build Java Native Interface files

JNI C files can be found in the following location:

‘Application/IR_Scanner/jni’

Open the file nativeIRDetect.c from above location and edit line 53 to include the path of the Anrdoid 
Directory i2c-dev.h file:

#include<..../8060_v3/kernel/include/linux/i2c-dev.h>

To re-build JNI files, enter the following commands:

$cd Application/IR_Scanner/jni
$sudo -s
$ …./android-ndk-r6b/ndk-build

Note: Download android-ndk from http://developer.android.com/sdk/ndk/index.html. This will generate 
the source file ‘libnativeIRDetect.so’ under the following path:

'Application/IR_Scanner/libs/armeabi/'

c. Clean and build the IR_Scanner project.

Under the Project tab, click the Clean option, select the IR_Scanner and click OK.

To build the IR_Scanner project, select the project IR_Scanner from the Package Explorer window. 
Under the Project tab, click Build Project.
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9. Install IR_Scanner Application to Android

The IR_Scanner application can be installed onto the DragonBoard by following the steps below.

a. The DragonBoard is powered up and running Android.

b. Select the IR_Scanner project from the Package Explorer window on the left side of the Eclipse IDE. 
Click Run > Run as > Android Application. This will create and install the IR_Scanner application on 
the board.

 The Android package file (apk) can be found in the following location:

'Application/IR_Scanner/bin'

10. Run the Qualcomm IR-I2C Bridge Demo

a. Power off the iCEdragon Demo Board by toggling the switch (sw1) to the OFF state.

b. Power off and Restart the DragonBoard.

c. After the Android boot is complete and the home screen appears, switch on the board by toggling the 
switch (sw1) to the ON position.

d. On the DragonBoard go to the Android application menu and open the application labled IR_Scanner. 
The application logo is shown below.

e. Now the application is ready to detect a key press from the Sony remote (RMTD301).

Dragonboard

Power Switch

iCE-Dragon

Power Switch

(sw1)

OFF ON
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11. Debugging and Troubleshooting in the Kernel and Application 

To debug board support files using printk statements, use printk functions with the KERN_EMERG flag.

Example: Printk(KERN_EMERG "MY PRINT LOG\n");

The printk lines can be shown on a serial console.

To enable the Android Debug Log, add the following line in the Android.mk file of your jni directory:

LOCAL_LDLIBS := -llo

Inside JNI ‘C’ code use android_log_print lines in the following format to debug:

#include<android/log.h> 
#define  LOG_TAG    "nativeIrdetect"

Example:

__android_log_print(ANDROID_LOG_DEBUG, LOG_TAG,"PRINT LOG \n");
__android_log_print(ANDROID_LOG_INFO, "PRINT VALUE=", "%d\n", value);

The debug lines can be observed on a serial console by using the ‘#logcat’ command.

If the android application does not respond, follow the steps below in the correct sequence:

a. Power off the iCEdragon Demo Board by toggling the switch (sw1) to the OFF position.

b. Close the IR_scanner application process running in the background.

Android menu > Settings > Applications > Manage Applications > IR_Scanner > Force Stop 

c. Power-on the board by toggling the switch (sw1) to the ON position.

d. Open the IR_Scanner application from the Android menu and the application is ready to detect any 
key press.

Installing the DragonBoard USB Driver in Windows XP

1. Download and install the Android Software Development Kit (SDK).

2. Start the SDK Manager GUI and install the Google USB Driver package mentioned in the Extras subheading.

3. Copy [Android SDK Root]\extras\google\usb_driver to [Android SDK Root]\msm8655-mdp_usb_driver. If there 
is no such folder, create a new folder.

4. Open the android_winusb.inf (inside of the newly-created directory) file in Notepad or another non-format 
appending text editor. Clear the contents of the[Google.NTx86] and [Google.NTamd64] paragraphs so that they 
contain only the following:

[Google.NTx86]

;BSQUARE MDP8655

%SingleAdbInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00

%CompositeAdbInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00

%SingleBootLoaderInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00

(1.0, 31-OCTOBER-2012) Lattice Semiconductor Corporation

8 www.Latticesemi.com

Qualcomm IR-I2C Bridge

[Google.NTamd64]

;BSQUARE MDP8655

%SingleAdbInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00

%CompositeAdbInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00

%SingleBootLoaderInterface% = USB_Install, USB\ VID_05C6&PID_9025&MI_00
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5. To find VID number of the connected board, follow these steps:

a. Go to My Computer and right-click Properties.

b. In the System Properties window Go to Hardware > Device Manager.

c. In Device Manager you will find “Android Device”. Expand this and you will find “Android ADB Inter-
face”.

d. In Android ADB Interface right-click and go to Properties > Details. The details tab provides the 
Device Instance ID.

e. Copy the VID which is listed between USB\“ ”\.

6. Create and/or open the C:\Documents and Settings\[yourusername]\.android\adb_usb.ini file and make 
sure it contains only the hex string 0x05C6 (obtained from the step above).

7. Power on the device and connect it to the development machine. Be sure to point Windows to your newly-cre-
ated USB driver directory for your MSM8655. If Windows is unable to find the needed driver(s), point the driver 
search to the original USB driver located in [Android SDK Root]\extras\google\usb_driver.

Ordering Information

Description Ordering Part Number
China RoHS Environment-Friendly 

Use Period (EFUP)

iCEdragon Demo Board ICE40HX8K-DRAGON-EVN

Lattice USB Programming Cable HW-USBN-2A

Technical Support Assistance

Hotline: 1-800-LATTICE (North America)

+1-503-268-8001 (Outside North America)

e-mail: techsupport@latticesemi.com

Internet: www.latticesemi.com

Revision History

Date Version Change Summary

November 2012 01.0 Initial release.

© 2012 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as 
listed at www.latticesemi.com/legal. All other brand or product names are trademarks or registered trademarks of 
their respective holders. The specifications and information herein are subject to change without notice.
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1V8_DRGN
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1
2
3
4 5

6
7
8

RN2 22RN2 22
1
2
3
4 5

6
7
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BANK1

iCE40HX8K-CT256
U1B

BANK1

iCE40HX8K-CT256
U1B

PIO1_00/TDI
R14

PIO1_01/TMS
R15

PIO1_02/CLK
P14

PIO1_03/TDO
P15

TRST_B
N14

GBIN3/PIO1_27
H11 GBIN2/PIO1_28
H16

VCCIO1_01
H10

VCCIO1_02
C15

VCCIO1_03
H15

VCCIO1_04
N15

PIO1_04
P16

PIO1_05
M13

PIO1_06
M14

PIO1_07
L12

PIO1_08
N16

PIO1_09
L13

PIO1_10
L14

PIO1_11
K12

PIO1_12
M16

PIO1_13
J10

PIO1_14
M15

PIO1_15
J11

PIO1_16
L16

PIO1_17
K13

PIO1_18
K14

PIO1_19
J15

PIO1_20
K15

PIO1_21
K16

PIO1_22
J14

PIO1_23
J12
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J13

PIO1_25
J16

PIO1_26
H13

PIO1_29
H14
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PIO1_31
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G15
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G10

PIO1_34
F16
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E16

PIO1_39
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D16
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F14
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F12

PIO1_44
D15

PIO1_45
F11

PIO1_46
E14

PIO1_47
C16

PIO1_48
F13

PIO1_49
B16

PIO1_50
E13

PIO1_51
D14

R18
100

R18
100

R37 DNPR37 DNP

R24
100
R24
100

R40 DNPR40 DNP

J18
CONN PCB 8x2
J18
CONN PCB 8x2

16

2
4
6
8

10
12
14

1
3
5
7
9
11
13
15

J6
CONN PCB 8x2 SOCK
J6
CONN PCB 8x2 SOCK

16

2
4
6
8

10
12
14

1
3
5
7
9
11
13
15

J5
VCCIO1

J5
VCCIO1

2
4
6

1
3
5

R39 0R39 0

J9
Bank 1
J9
Bank 1

1
3
5
7
9

11
13
15
17
19

2
4
6
8
10
12
14
16
18
20

C30
1u

C30
1u

C34
10n

C34
10n

R29DNP R29DNP

C32
0.1u

C32
0.1u

C41
10n

C41
10n

R19
100
R19
100

C38
10n

C38
10n

C36
10n
C36

10n

J1
GND
J1
GND

1
R300 R300

R34 0R34 0

R22
10k
R22
10k
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BANK 2 CONNECTOR

LED INDICATORS

CLOCK OSCILLATOR

PIO2_43_R16

PIO2_41_T16

PIO2_35_T15
PIO2_36_T14

PIO2_38_T13

PIO2_34_T11
PIO2_33_T10

PIO2_29_R10

GBIN5_R9

PIO2_24_T9

PIO2_21_T8

PIO2_17_P8

PIO2_20_T7

PIO2_18_T6

PIO2_15_T5

PIO2_09_T3

PIO2_05_T2

PIO2_01_T1

GBIN4_K9

PIO2_35_T15 PIO2_36_T14
PIO2_34_T11

PIO2_33_T10 PIO2_29_R10
PIO2_24_T9

PIO2_21_T8 PIO2_17_P8
PIO2_20_T7 PIO2_18_T6
PIO2_15_T5 PIO2_09_T3

GBIN4_K9

PIO2_38_T13

PIO2_41_T16PIO2_43_R16

CDONE

CDONE

GBIN5_R9

PIO2_03_R2
PIO2_02_P4

PIO2_07_R3
PIO2_01_T1
PIO2_03_R2
PIO2_05_T2
PIO2_07_R3
PIO2_09_T3
PIO2_02_P4

VCCIO2

5V VCCIO2

VCC1V2

VCC2V5

VCC1V8

VCCVAR

VCCIO2
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VCCIO2

VCCIO2
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R43
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R43
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BANK2

iCE40HX8K-CT256
U1C

BANK2

iCE40HX8K-CT256
U1C

GBIN5/PIO2_26
R9 GBIN4/PIO2_27
K9

PLLGND_2
N8

PLLVCC2
L8

PIO2_44/CBSEL0
K11

PIO2_45/CBSEL1
P13

CDONE
M10

CRESET_B
N11

VCCIO2_01
K8

VCCIO2_02
P3

VCCIO2_03
R13

VCCIO2_04
R8

PIO2_00
N6

PIO2_01
T1

PIO2_02
P4

PIO2_03
R2

PIO2_04
N5

PIO2_05
T2

PIO2_06
P5

PIO2_07
R3

PIO2_08
R5

PIO2_09
T3

PIO2_10
R4

PIO2_11
M7

PIO2_12
N7

PIO2_13
P6

PIO2_14
M8

PIO2_15
T5

PIO2_16
R6

PIO2_17
P8

PIO2_18
T6

PIO2_19
L9

PIO2_20
T7

PIO2_21
T8

PIO2_22
P7

PIO2_23
N9

PIO2_24
T9

PIO2_25
M9

PIO2_28
P9

PIO2_29
R10

PIO2_30
L10

PIO2_31
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N10

PIO2_33
T10
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T11
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T15
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T14
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M11
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T13

PIO2_39
N12

PIO2_40
L11

PIO2_41
T16

PIO2_42
M12

PIO2_43
R16

D5
LD5
D5
LD5

C52
10n

C52
10n

C51
0.1u

C51
0.1u

R21
10k
R21
10k

SW2

CRST

SW2

CRST

C55
10n

C55
10n

C50
1u

C50
1u

C54
10n

C54
10n

C49
10u

C49
10u

C53
10n

C53
10n

R45
680
R45
680

C48
0.1u
C48
0.1u

D3
LD3
D3
LD3

J14
VCCIO2

J14
VCCIO2

2
4
6

1
3
5

R44
680
R44
680

D4
LD4
D4
LD4

R46
680
R46
680

J15
GND
J15
GND

1

C15
0.1u
C15
0.1u

ASFLMB-27.000MHZ-LC-T
U3
ASFLMB-27.000MHZ-LC-T
U3

GND
2

VDD
4

STDBY#
1

OUT
3

D2
LD2
D2
LD2

R17
680
R17
680

J12
STDBY

J12
STDBY

1
2

R47
680
R47
680

R23100 R23100

J13 Bank 2J13 Bank 2

1
3
5
7
9

11
13
15
17
19

2
4
6
8
10
12
14
16
18
20

D1
LD1
D1
LD1

R42
680
R42
680

R28
10k
R28
10k

D9
DONE

D9
DONE

D6
LD6
D6
LD6
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DP00B
DP00A

DP02B_C2
DP02A_C1

DP03B
DP03A

DP05B
DP05A

DP12B
DP13A_J3

DP12A

DP13B_H1

DP14B_J1
DP14A_J2

DP15A
DP15B

DP00A_E4

DP00B_B2DP00B

DP00A

DP03A_F4

DP03B_D2DP03B

DP03A

DP05A_G4

DP05B_E3DP05B

DP05A

DP12A_J5

DP12B_G1DP12B

DP12A

DP15A_K1

DP15B_K3DP15B

DP15A

DP00B_B2 DP00A_E4
DP02B_C2 DP02A_C1
DP03B_D2 DP03A_F4
DP05B_E3 DP05A_G4

DP13B_H1
DP14B_J1 DP14A_J2

DP15A_K1DP15B_K3

DP12A_J5DP12B_G1
DP13A_J3

VCCIO3

VCC2V5

VCC1V8

VCCVAR

VCCIO3

5V

VCCIO3
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C35
0.1u

C35
0.1u

C33
10n

C33
10n

C23
1u
C23

1u
C27

10n
C27

10n
C31

10n
C31

10n
C29

10n
C29

10n

SW3

USRSW

SW3

USRSW

R10
Rs
R10
Rs

R8
Rs
R8
Rs

R27

10k

R27

10k

R2
Rs
R2
Rs

J16
GND
J16
GND

1

R9
Rp
R9
Rp

J7
VCCIO3

J7
VCCIO3

2
4
6

1
3
5

R7
Rs
R7
Rs

BANK3

iCE40HX8K-CT256
U1D

BANK3

iCE40HX8K-CT256
U1D

GBIN7/PIO3_25/DP12B
G1

GBIN6/PIO3_26/DP13A
J3

VCCIO3_01
E1

VCCIO3_02
G6

VCCIO3_03
J6

VCCIO3_04
N1

PIO3_00/DP00A
E4

PIO3_01/DP00B
B2

PIO3_02/DP01A
F5

PIO3_03/DP01B
B1

PIO3_04/DP02A
C1

PIO3_05/DP02B
C2

PIO3_06/DP03A
F4

PIO3_07/DP03B
D2

PIO3_08/DP04A
G5

PIO3_09/DP04B
D1

PIO3_10/DP05A
G4

PIO3_11/DP05B
E3

PIO3_12/DP06A
H5

PIO3_13/DP06B
E2

PIO3_14/DP07A
G3

PIO3_15/DP07B
F3

PIO3_16/DP08A
H3

PIO3_17/DP08B
F2

PIO3_18/DP09A
H6

PIO3_19/DP09B
F1

PIO3_20/DP10A
H4

PIO3_21/DP10B
G2

PIO3_22/DP11A
J4

PIO3_23/DP11B
H2

PIO3_24/DP12A
J5

PIO3_27/DP13B
H1

PIO3_28/DP14A
J2

PIO3_29/DP14B
J1

PIO3_30/DP15A
K1

PIO3_31/DP15B
K3

PIO3_32/DP16A
L4

PIO3_33/DP16B
L1

PIO3_34/DP17A
K4

PIO3_35/DP17B
M1

PIO3_36/DP18A
L6

PIO3_37/DP18B
L3

PIO3_38/DP19A
K5

PIO3_39/DP19B
M2

PIO3_40/DP20A
L7

PIO3_41/DP20B
N2

PIO3_42/DP21A
M6

PIO3_43/DP21B
M3

PIO3_44/DP22A
L5

PIO3_45/DP22B
N3

PIO3_46/DP23A
P1

PIO3_47/DP23B
M4

PIO3_48/DP24A
P2

PIO3_49/DP24B
M5

PIO3_50/DP25A
R1

PIO3_51/DP25B
N4

R14
Rs
R14
Rs

R5
Rs
R5
Rs

R13
Rs
R13
Rs

R16
Rs
R16
Rs

R6
Rp
R6
Rp

R11
Rs
R11
Rs

R4
Rs
R4
Rs

R15
Rp
R15
Rp

R12
Rp
R12
Rp

R3
Rp
R3
Rp

J11
Bank 3
J11
Bank 3

1
3
5
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VCCVAR VCC3V3
USB5V

VCCVAR

VCC1V2
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2V85_DRGN
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C46
0.1u
C46
0.1u

C56
0.1u
C56
0.1u

C45
10u

C45
10u

SW1
PWR
SW1
PWR

123

456

7 8

L2
100Mhz, 26 ohms

L2
100Mhz, 26 ohms

R25
680
R25
680

D10
PWR

D10
PWR

D11
PMEG2005CT,215
D11
PMEG2005CT,215

3
1

2

C20
10u

C20
10u

C21
47u
C21
47u

C44
0.1u
C44
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U7
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U7

1.8VO
1

1.8EN
3

1.2EN
4

1.2VO
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2

C22
0.1u
C22
0.1u

5VD-D+IDG

USB PWR
J20

5VD-D+IDG

USB PWR
J20

1234

S2

5

S1
S3

S4

C18
47u
C18
47u

C19
0.1u
C19
0.1u

J4
GND
J4
GND

1

L1
100MHz, 26 ohms
L1
100MHz, 26 ohms

J19
PWRSEL
J19
PWRSEL

1 2 3
C58
47u
C58
47u

MIC5320-SJYD6 TR
U5
MIC5320-SJYD6 TR
U5

3.3VO
4

3.3EN
6

2.5EN
1

2.5VO
5
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3
G
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D

2

C47
47u
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C57
47u
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FLSH_CSn
FLSH_MOSIFLSH_SCK

FLSH_MISO

FLSH_CSn
FLSH_SCK

FLSH_MISO

FLSH_MOSI

FLSH_MISO

FLSH_SCK

FLSH_CSn

FLSH_MOSI

VCCVAR
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VCC1V2
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Title

Size Document Number Rev

Date: Sheet of

102-349r1p1-0612 1.1

iCE DRAGON - Decoupling and SPI Configuration

A

6 6Saturday, June 23, 2012

Title

Size Document Number Rev

Date: Sheet of

102-349r1p1-0612 1.1

iCE DRAGON - Decoupling and SPI Configuration

A

6 6Saturday, June 23, 2012

Title

Size Document Number Rev

Date: Sheet of

102-349r1p1-0612 1.1

iCE DRAGON - Decoupling and SPI Configuration

A

6 6Saturday, June 23, 2012

C37
10n

C37
10n

C40
10n

C40
10n

R33
10k
R33
10k

C12
0.1u

C12
0.1u

R41
10k
R41
10k

C42
10n

C42
10n

C11
1u

C11
1u

C8
0.1u

C8
0.1u

J10
FST
J10
FST

1

M25P80
U6
M25P80
U6

SDI
5

SCK
6

WP
3

CS
1

SDO
2

HOLD
7

8

VCC

4

GND

C14
0.1u
C14
0.1u

C13
10n
C13
10n

C24
0.1u
C24
0.1u

C28
1u

C28
1u

POWER

iCE40HX8K-CT256
U1F

POWER

iCE40HX8K-CT256
U1F

GND_01
A12

GND_02
A4

GND_03
E15

GND_04
G7

GND_05
G8

GND_06
G9

GND_07
H7

GND_08
H8

GND_09
H9

GND_10
J7

GND_11
J8

GND_12
J9

GND_13
K2

GND_14
K7

GND_15
L15

GND_16
R7

GND_17
T12

GND_18
T4

VCC_01
A14

VCC_02
F10

VCC_03
F6

VCC_04
K10

VCC_05
K6

VCC_06
L2

VPP_FAST
D12

VPP_2V5
E12

SPI

iCE40HX8K-CT256
U1E

SPI

iCE40HX8K-CT256
U1E

SPI_VCC
N13

PIOS_00/SPI_SO
P12

PIOS_01/SPI_SI
P11

PIOS_02/SPI_SCK
R11

PIOS_03/SPI_SS_B
R12

R36
10k
R36
10k

C7
0.1u

C7
0.1u

C39
10n

C39
10n

C16
10n

C16
10n

C9
1u

C9
1u

C43
10n

C43
10n

J8
SPI PGM
J8
SPI PGM

SS2
1

GND1
2

SS3
3

NC2
4

MISO
5

NC1
6

SCLK
7

MOSI
8

SS1
9

GND2
10
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